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Vorwort

Dieses Lehrbuch entstammt einem Skript, welches speziell für den LabVIEW-Unterricht an
Berufs- und höheren Fachschulen konzipiert wurde. Dabei stand ein starker Bezug zur Praxis
und der täglichen Arbeit mit LabVIEW im Vordergrund.

Meine Tätigkeit als Dozent an der höheren Fachschule Uster sowie die Erfahrung als Dienst-
leister für LabVIEW-Applikationen erlauben einen Blick auf die Thematik von unterschiedli-
chen Seiten. Das gibt mir die Chance, die Grundlagen so vermitteln, wie sie auch in der Praxis
später zur Anwendung kommen.

Dies ist auch der Hauptunterschied zu anderen Lehrmitteln, welche teils sehr vertieft die theo-
retischen Grundlangen von LabVIEW thematisieren. Dies hat durchaus seine Berechtigung,
wenn man sich über einen längeren Zeitraum Wissen aneignen will, ist allerdings für einen
raschen Einstieg mit baldigen Programmiererfolgen eher ungeeignet.

Der Inhalt besteht sowohl aus der Beschreibung grundsätzlicher Konzepte grafischer Program-
mierung als auch weiterführenden Anwendungen und Best-Practice-Anwendungen aus der
Industrie. Dabei erhebt das Buch keinerlei Anspruch auf Vollständigkeit, was aufgrund des
großen Anwendungsbereichs und der vielfältig nutzbaren Funktionen auch nicht realistisch
ist. Behandelt werden die aus meiner Sicht grundlegenden Thematiken, die es dem LabVIEW-
Einsteiger ermöglichen, möglichst schnell und mit Rücksicht auf aktuelle Designrichtlinien
lauffähige Mess- und Testumgebungen zu realisieren. Sehr spezifische Themen werden dabei
nicht berücksichtigt. Bedingte Grundkenntnisse über programmiertechnische Begriffe werden
allerdings vorausgesetzt. Es wird speziell darauf geachtet, einen konsequenten Programmier-
stil, wie ihn National Instruments vorschlägt, umzusetzen.

Jedes Kapitel enthält eine Sammlung von Übungen, welche dem Benutzer die jeweils prak-
tische Umsetzung der in diesem Buch behandelten Themen in LabVIEW ermöglicht. Es wird
sehr empfohlen, diese Übungen durchzuführen, um sich nach und nach mit LabVIEW vertraut
zu machen. Die Grundlagen der ersten Kapitel werden für die Durchführung von Übungen
späterer Kapitel benötigt.

Die Musterlösungen zu sämtlichen Übungen sowie zusätzliche Demos zu einzelnen Kapi-
teln lassen sich als Softwarepaket unter https://www.krauer-engineering.ch/labview-fuer-
einsteiger/ herunterladen. Zur Bearbeitung benötigen Sie lediglich ein Tool, um die ZIP-Datei
zu entpacken, sowie die Entwicklungsumgebung LabVIEW, welche Ihnen mit diesem Buch zur
Verfügung gestellt wird. Die Lösungen der Übungen stellen immer nur eine mögliche Variante
dar. Es gibt fast immer mehrere Lösungswege und Möglichkeiten, eine Aufgabe zu bearbeiten.

Sämtliche Illustrationen wurden mit der englischen Version LabVIEW 2015.0f2 generiert. Da
die englische Version in der Industrie weit verbreitet ist, sind die meisten spezifischen Begriffe
ebenfalls in Englisch gehalten. Eine Vermischung kann allerdings nicht vollkommen vermie-
den werden, weshalb sich durchaus auch deutsche Begriffe für Elemente und Funktionen in
LabVIEW in diesem Buch wiederfinden.

https://www.krauer-engineering.ch/labview-fuer-einsteiger/
https://www.krauer-engineering.ch/labview-fuer-einsteiger/
https://www.krauer-engineering.ch/labview-fuer-einsteiger/
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Danksagungen möchte ich vor allem Manuel Leppert vom Hanser Verlag aussprechen. Er hat
sich für dieses Buchprojekt viel Zeit genommen und war mir stets eine verlässliche Anlauf-
stelle bei Fragen. Ein ebenso großer Dank gebührt all den Studierenden, die mich auf Fehler
oder Ungereimtheiten in meinem Unterrichtsskript hingewiesen und damit zur wesentlichen
Verbesserung in Form dieses Lehrmittels beigetragen haben.
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Ich wünsche allen Leserinnen und Lesern viel Erfolg mit der Arbeit dieses Buches.

Rapperswil-Jona, im November 2018 Nicolas Krauer

Hinweis des Verlags
Sehr geehrte/r Leser/in,

die für das Selbststudium mit diesem Buch notwendige Software LabVIEW können Sie über
die folgenden Optionen beziehen:

1. Bezug der Student Install Option:

Als Student einer Hochschule, welche eine Academic Site Licence vorhält, haben Sie die Mög-
lichkeit über die sog. Student Install Option eine jährliche Lizenz über ihre Hochschule zu
beziehen, so lange Sie bei dieser eingeschrieben sind. Die Student Install Option umfasst das
gleiche Softwarepaket wie die Academic Site Licence (http://www.ni.com/white-paper/8115/
en/). Informationen hierzu finden Sie unter dem folgenden Link (https://knowledge.ni.com/
KnowledgeArticleDetails?id=kA00Z0000019MbaSAE). Der Bezug dieser Lizenz erfolgt direkt
über Ihre Hochschule und nicht über National Instruments. Bitte kontaktieren Sie hierfür Ihre
Lokale IT oder Ihren LabVIEW Academy Instructor.

2. Bezug einer Evaluierungslizenz:

Sie haben die Möglichkeit über ni.com/download die aktuellste LabVIEW Version zur Evalu-
ierung herunterzuladen. Nach der Installation können Sie die Software 7 Tage lang kostenfrei
nutzen. Durch die Verknüpfung der Installation mit einem ni.com-Profil haben Sie die Mög-
lichkeit, die Evaluierung auf 45 Tage zu verlängern.

3. Bezug der LabVIEW Student Edition/LabVIEW Home Edition:

Sie haben die Möglichkeit, eine Lizenz der Software über den lokalen Reseller, https://www.
conrad.de zu erwerben. Hierbei haben Sie die Wahl zwischen der LabVIEW Student Edition
(erfordert einen Immatrikulationsnachweis) oder der LabVIEW Home Edition. Diese Software-
pakete umfassen das LabVIEW Full Development System, das Control Design and Simulation
sowie das MathScript RT Module.

Wir wünschen Ihnen viel Erfolg beim Einstieg in die Welt der grafischen Programmierung.

Carl Hanser Verlag

http://www.ni.com/white-paper/8115/en/
http://www.ni.com/white-paper/8115/en/
http://www.ni.com/white-paper/8115/en/
https://knowledge.ni.com/KnowledgeArticleDetails?id=kA00Z0000019MbaSAE
https://knowledge.ni.com/KnowledgeArticleDetails?id=kA00Z0000019MbaSAE
https://knowledge.ni.com/KnowledgeArticleDetails?id=kA00Z0000019MbaSAE
https://www.conrad.de
https://www.conrad.de
https://www.conrad.de
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1 Entwicklungsumgebung

Dieses Kapitel dient als Einstieg in die Entwicklungsumgebung. Es werden die grundlegenden
Funktionen erklärt, der Umgang mit den Tools von LabVIEW erläutert und erste Projekte er-
stellt. Mit den Übungsaufgaben am Ende des Kapitels kann das LabVIEW-Handling geübt und
das angeeignete Wissen vertieft werden.

1.1 Was ist LabVIEW?
LabVIEW ist eine grafische Programmierumgebung zum Entwickeln von anspruchsvollen
Mess-, Prüf-, Steuer- und Regelaufgaben. Dabei wird auf die sogenannte Virtual Instrumen-
tation (virtuelle Instrumentierung) von Messgeräten gesetzt, also reale Messgeräte durch
Softwaretools abgebildet und miteinander kombiniert. So können nicht wie bei einem kon-
ventionellen Multimeter nur Strom und Spannung gemessen, sondern auch gleich noch ein
Oszilloskop, ein Generator oder andere beliebige Messgeräte in einer einzigen Applikation
verwendet werden (Bild 1.1).

Bild 1.1 Eine einzelne Applikation zur Erfassung, Auswertung und Darstellung

Ein LabVIEW-Programm oder eine einzelne Datei oder Funktion wird deshalb auch als VI (Vir-
tual Instrument) bezeichnet. Die Dateiendung solcher Dateien lautet ebenfalls .vi.
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Es findet also mit LabVIEW eine Vernetzung von klassischen Messgeräten mit der IT-Welt statt.
Dabei können, sofern es die entsprechende Hardware zulässt, eine sehr große Anzahl von Da-
tenkanälen parallel erfasst und verarbeitet werden. LabVIEW arbeitet mit einer Vielzahl an
Hardwareprodukten und beinhaltet eine große Anzahl von Analysefunktionen.

1.2 Grundeinstellungen
Wer die Entwicklungsumgebung nach eigenen Vorlieben konfigurieren möchte, hat unter
Tools → Options die Möglichkeit, verschiedenste Grundeinstellungen vorzunehmen. Auf der
linken Seite wählt man die Kategorie, während rechts die Optionen zur entsprechenden Kate-
gorie zu sehen sind (Bild 1.2).

Bild 1.2 Einstellungen des Blockdiagramms
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Die meisten Optionen können auf dem Standard belassen werden. Lediglich für das Blockdia-
gramm bietet es sich an, darauf zu achten, dass die Checkbox Place front panel terminals as
icons nicht selektiert ist. Dies spart Platz und erhöht die Übersicht im Blockdiagramm.

1.3 Bestandteile eines VIs
Ein LabVIEW-Programm kann unter Umständen aus nur einem einzigen VI, also einer einzel-
nen Datei bestehen. Das VI unterscheidet drei wesentliche Hauptbestandteile (Bild 1.3):

■ Frontpanel: ist die Bedienoberfläche, enthält Controls (Bedienelemente, zur Eingabe von
Daten) und Indicators (Anzeigeelemente, zur Ausgabe von Daten)

■ Blockdiagramm: enthält den grafischen Quellcode und damit die Funktion des VIs, enthält
Anschlüsse für Controls und Indicators auf dem Frontpanel

■ Symbol/Anschlussblock: repräsentiert das VI und ermöglicht die Verwendung als SubVI,
zeigt die Belegung der Ein- und Ausgänge des VIs an

Bild 1.3 Hauptbestandteile eines VIs
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1.3.1 Frontpanel

Das Frontpanel stellt in LabVIEW die Schnittstelle zum Benutzer dar oder zu anderen VIs. Es
beinhaltet sämtliche Eingänge und Ausgänge, die für eine Interaktion mit der Welt außerhalb
des VIs benötigt werden (Bild 1.4).

Bild 1.4 Frontpanel eines VIs

Die Elemente werden in zwei Gruppen unterteilt: in Bedien- und Anzeigeelemente (Tabel-
le 1.1).

Tabelle 1.1 Controls (Bedienelemente) und Indicators (Anzeigeelemente)

Controls Indicators
Buttons, Drehknöpfe, Schieberegler, Texteingabe-
felder etc.

LEDs, Graphen, Diagramme, Textboxen etc.

Die Symbolleiste des Frontpanels enthält verschiedene Funktionen zur Ausführung des VIs
sowie zur Gestaltung und Anordnung der vorhandenen Frontpanel-Elemente (Bild 1.5).

Bild 1.5 Symbolleiste des Frontpanels
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Die in Tabelle 1.2 beschriebenen Buttons dienen der Kontrolle der Ausführung des entspre-
chenden VIs.

Tabelle 1.2 Funktionelle Buttons der Symbolleiste

Ausführen des VIs

Wiederholtes Ausführen des VIs

Sofortiger Abbruch der Ausführung des VIs

Pausieren der Ausführung des VIs

Mit dem Dropdown-Menü, gleich daneben, lassen sich Schriftarten der Frontpanel-Elemente
und deren Aussehen verändern (Bild 1.6).

Bild 1.6 Schrifteditor

Die weiteren Funktionen dienen der optimierten Darstellung und der Ausrichtung der Ele-
mente auf dem Frontpanel und haben keinen Einfluss auf das Programmverhalten des VIs.
Trotzdem sollte ein Frontpanel ansprechend sein und alle Controls und Indicators nach ei-
nem übersichtlichen Muster angeordnet sein. Die folgenden Tools in Tabelle 1.3 helfen dem
Programmierer bei der Gestaltung.

Die verschiedenen Datentypen werden auf dem Frontpanel als Controls und Indicators darge-
stellt (Tabelle 1.4).

Tabelle 1.3 Funktionen zur Darstellung und Ausrichtung von Frontpanel-Elementen

Align – Ausrichtung der Elemente:
Mit diesem Tool können selektierte Elemente sowohl
horizontal (linker Rand, Mitte, rechter Rand) als auch
vertikal (oberer Rand, Mitte, unterer Rand) zueinander
ausgerichtet werden.

Distribute – Verteilen der Elemente:
Mit diesem Tool können selektierte Elemente
gleichmäßig zueinander verteilt werden, z. B. in gleiche
Abstände zwischen mehreren Elementen (Selektion).
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Tabelle 1.3 Funktionen zur Darstellung und Ausrichtung von Frontpanel-Elementen (Fortsetzung)

Resize – Größenanpassung von Elementen:
Mit diesem Tool können selektierte Elemente auf die
gleichen Dimensionen getrimmt werden.

Reorder – Gruppieren und Ebenen festlegen:
Mit diesem Tool können selektierte Elemente gruppiert
und gelockt werden. Ebenfalls kann bei
übereinanderliegenden Elementen die Reihenfolge
bestimmt und Elemente in den Vorder- bzw.
Hintergrund verschoben werden.

Tabelle 1.4 Controls und Indicators der gebräuchlichsten Datentypen in LabVIEW

Mit einem numerischen Datentyp können
Zahlen verschiedenen Typs dargestellt
werden, z. B. Gleitkommazahlen,
ganzzahlige Typen etc.
Numerische Controls sowie Indicators
gehören zu den am häufigsten
eingesetzten Elementen.
Mit dem booleschen Datentyp lassen
sich die Zustände TRUE und FALSE
darstellen. Andere Elemente außer
Buttons sind z. B. Slide Switches oder
Radio Buttons.
Strings sind zusammengesetzte Ketten
aus ASCII-Zeichen. Häufig werden
Controls als Eingabeelemente für
Benutzertext verwendet, Indicators z. B.
zur Anzeige einer Statusmeldung oder
anderer Messages.

Das Frontpanel dient als Benutzeroberfläche eines VIs.
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1.3.2 Blockdiagramm

Hinter dem Blockdiagramm versteckt sich die eigentliche Funktionalität des VIs (Bild 1.7). Im
Gegensatz zum Frontpanel ist das Blockdiagramm für den Benutzer zur Laufzeit nicht sichtbar.
Zu typischen Objekten des Blockdiagramms zählen Anschlüsse, SubVIs, Funktionen, Konstan-
ten, Strukturen und Wires (Verbindungen), über welche die Daten zwischen den Objekten des
Blockdiagramms übertragen werden.

Bild 1.7 Blockdiagramm eines VIs

Die Symbolleiste des Blockdiagramms (Bild 1.8) enthält zum Teil dieselben Funktionen wie
diejenige des Frontpanels, ist aber zusätzlich mit Debug- und Analysetools ausgerüstet (Tabel-
le 1.5).

Bild 1.8 Symbolleiste des Blockdiagramms

Tabelle 1.5 Debugging-Funktionen des Blockdiagramms

Highlight-Modus: Ausführung des Programms wird extrem verlangsamt,
sodass alle Werte auf den Wires sichtbar werden
Verbindungswerte speichern: Wenn eingeschaltet, behalten die Wires ihre
Werte, auch wenn das Signal das Wire schon passiert hat
Step into, step over, step out: Programmausführung im Einzelschritt-Modus
zur Kontrolle aller Signale

Das Blockdiagramm enthält den Programmcode und die Funktionalität eines VIs.
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Die Controls (Bedienelemente) und Indicators (Anzeigeelemente), welche bereits im Front-
panel eingesetzt wurden, müssen im Blockdiagramm natürlich funktional eingebunden wer-
den.

In Bild 1.9 sind die gleichen Controls und Indicators abgebildet, welche im Frontpanel schon
in Tabelle 1.4 aufgeführt wurden. Grundsätzlich unterscheiden sich Controls und Indicators
im Blockdiagramm aufgrund der Position des schwarzen Anschlusspfeils (wo eine Verbindung
erfolgen muss) sowie der Breite des Rahmens. Controls sind immer Datenquellen, weshalb
der Ausgangsanschluss rechts liegt, Indicators sind die Verbraucher der Daten, weshalb der
Eingang stets links liegt. Die Farbe des Elements, egal ob Control oder Indicator, entspricht der
Farbe des enthaltenen Datentyps.

Bild 1.9 Controls und Indicators im Blockdiagramm

Die Elemente können im Blockdiagramm auch als Icons dargestellt werden (Bild 1.10). Even-
tuell ist dies bei der Installation auch so voreingestellt. Da diese Ansicht jedoch keinen Vorteil
bringt und erst noch mehr Platz benötigt als die normalen Symbole, sollten die Anschlüsse nie
als Icons angezeigt werden.

Bild 1.10 Darstellung der Elemente als Icons

Um einzelne Controls oder Indicators zu ändern, muss mit Rechtsklick auf das Element und
unter View As Icon der Haken entfernt werden. Um die Einstellung für alle zukünftig platzierten
Elemente zu setzen, muss unter Tools → Options in der Kategorie Block Diagram der entspre-
chende Haken entfernt werden (Bild 1.11).

Bild 1.11 Options Dialog
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1.3.3 Symbol und Anschlussblock

Jedes VI verfügt über ein Symbol und einen Anschlussblock. Wird ein VI im Programmcode
(Blockdiagramm) eines anderen VIs verwendet, ist es wichtig, dass es auf den ersten Blick
identifizierbar ist und der Programmierer anhand des Symbols erkennt, welche Funktion das
VI übernimmt. In Bild 1.7 befindet sich ein VI mit dem Namen Thermometer (Demo).vi im
Programmcode des Haupt-VIs. Anhand des Symbols ist klar, dass sich hinter dem VI eine Tem-
peraturapplikation verbergen muss.

Das Symbol kann einfach über einen Doppelklick auf das VI-Symbol in der rechten oberen
Ecke des Frontpanels oder des Blockdiagramms editiert werden. Darauf öffnet sich der Icon-
Editor (Bild 1.12), wo Text und vordefinierte Icons im 32×32 Pixel großen Symbolfeld platziert
werden können.

Bild 1.12 VI Icon-Editor

Das Symbol dient der einfachen Erkennung des VIs, wenn es innerhalb von anderen VIs ver-
wendet wird. Dabei muss nicht zwingend eine Grafik als Symbol verwendet werden, es reicht
auch eine kryptische Beschreibung oder eine Kombination von Symbol und Text. In Bild 1.13
sind Beispiele aussagekräftiger VI-Symbole dargestellt.

Bild 1.13 Beispiele von aussagekräftigen VI-Symbolen

Jedes VI muss mit einem individuellen Symbol ausgestattet sein.

Der Anschlussblock eines VIs ist die Schnittstelle zu einem übergeordneten VI. Er definiert, an
welchen Ein-/Ausgängen welche Daten dem VI übergeben bzw. vom VI zurückgegeben wer-
den. Werden die einzelnen Felder des Anschlussblocks mit Frontpanel-Elementen verbunden,
nehmen sie automatisch die Farbe des entsprechenden Datentyps an. Hierzu kann mit der
Drahtrolle (automatisches Tool) auf ein leeres Feld des Anschlussblocks geklickt werden und
danach auf das Frontpanel-Element, welches mit dem Feld verbunden werden soll (Bild 1.14).
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Bild 1.14 Anschlussblock eines VIs

Für die Verwendung in einem übergeordneten VI muss der Anschlussblock definiert sein, um
Werte übergeben und übernehmen zu können.

Bild 1.15 Verwendung eines VIs mit Ein- und Ausgängen

Für den Anschlussblock stehen verschiedene Muster mit einer kleineren bis größeren Zahl An-
schlüsse zur Verfügung. Im Anschlussblock mit einem Rechtsklick auf Patterns lässt sich das
Muster verändern (Bild 1.16).

In LabVIEW wird nach dem Datenflussprinzip programmiert (Kapitel 3). Das heißt, die Ver-
arbeitung verläuft von links nach rechts. Deshalb ist es wichtig, diesem Prinzip auch bei der
Belegung von Anschlussblöcken Rechnung zu tragen. Eingänge werden grundsätzlich auf der
linken Seite verbunden, Ausgänge rechts, wie in Bild 1.17 dargestellt. Etwaige zusätzliche An-
schlussfelder oben und unten werden erst verwendet, wenn die seitlichen Anschlüsse nicht
mehr ausreichen.
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Bild 1.16 Vordefinierte Anschlussmuster

Bild 1.17 Belegung eines 4×2×2×4 Anschlussblocks

1.4 Kontexthilfe
Die Kontexthilfe ist ein Werkzeug zur schnellen Visualisierung von Informationen zu bestimm-
ten VIs, Funktionen, Knoten etc. Sie zeigt jeweils immer gerade Informationen des Elements
an, über welchem sich der Mauszeiger gerade befindet. In Bild 1.18 befindet sich der Mauszei-
ger über dem eingekreisten Eigenschaftsknoten, folglich zeigt die Kontexthilfe die Beschrei-
bung von Eigenschaftsknoten an.
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Reicht die angezeigte Information nicht aus, gelangt man mittels des Links Detailed help direkt
in die ausführliche Hilfe des Objekts.

Die Kontexthilfe kann im Menu unter Help → Show Context Help eingeschaltet werden und
befindet sich im aktivierten Zustand immer im Vordergrund aller anderen offenen LabVIEW-
Fenster.

Bild 1.18 Kontexthilfe im Blockdiagramm

1.5 Paletten
Sämtliche Funktionen, Elemente und Knoten sind in LabVIEW in sogenannten Paletten orga-
nisiert. Dies gilt sowohl für das Frontpanel (Elemente) als auch für das Blockdiagramm (Funk-
tionen etc.).

Beim Öffnen oder Erstellen eines neuen VIs sind die Controls Palette (Frontpanel) und die
Functions Palette (Blockdiagramm) unter Umständen noch nicht sichtbar. Ist dies der Fall,
können sie unter View → Controls Palette und View → Functions Palette aktiviert werden.

Die zuoberst angeordnete Palette ist immer automatisch aufgeklappt, sodass schnell auf die
Elemente und Funktionen zugegriffen werden kann. In Bild 1.19 ist dies die Palette Silver. Die
anderen sichtbaren Paletten (hier: Modern und User Controls) werden bei einem Anwählen
aufgeklappt. Der Benutzer kann per Drag & Drop die Paletten innerhalb der Liste verschieben
und die von ihm bevorzugte Palette ganz oben platzieren.

Es besteht die Möglichkeit, die zu Beginn sichtbaren Paletten zu ändern. Unter Customize →
Change Visible Palettes. . . werden einfach diejenigen Paletten angewählt, die immer sichtbar
sein sollen (Bild 1.20). In der Regel sind das nur zwei bis drei, nämlich diejenigen, mit denen
der Programmierer oft arbeitet.
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Bild 1.19 Controls-Palette des Frontpanels

Bild 1.20 Änderung der sichtbaren Paletten
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Bei den Frontpanel-Paletten werden grundsätzlich vier verschiedene Darstellungsarten für
dieselben Elemente (nicht alle Elemente sind in allen Paletten vorhanden) unterschieden. Die
in Bild 1.21 gezeigten Darstellungsarten der exakt gleichen Elemente können vom Benutzer
nach eigenem Empfinden ausgewählt werden.

Bild 1.21 Vier Darstellungsvarianten der Frontpanel-Elemente

Grundsätzlich ist die Palette Silber (Bild 1.21 unten links) die neueste und am ehesten dem
Look moderner Betriebssysteme angepasst. Dazu umfasst sie auch die meisten Elemente, wes-
halb sie sich eignet, um übersichtliche und gefällige Benutzeroberflächen zu erstellen.

Die Palette System (Bild 1.21 oben rechts) passt sich automatisch dem verwendeten Betriebs-
system an und lehnt sich an dessen Design an.

Das früher (und auch heute noch) oft verwendete Set der Palette Modern (Bild 1.21 oben links)
ist eher technisch ausgelegt und nicht so sehr auf das Erscheinungsbild bedacht.

In der Praxis fast nie anzutreffen sind die Elemente der Palette Klassisch (Bild 1.21 unten
rechts). Zudem sind in dieser Palette auch diverse Controls anderer Paletten nicht verfügbar.

Für die Darstellung von Benutzeroberflächen empfiehlt sich die Verwendung von Elementen
einer einzigen Palette.

Aufgabe 1.1: Sichtbare Paletten


